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RESUMEN

SISTEMA DE ANALISIS DE ACTIVIDAD CEREBRAL EEG DURANTE LA
EJECUCION DE TAREAS COGNITIVAS

En el siguiente estudio se presenta el desarrollo de un software para el analisis cuantitativo de
sefales de Electroencefalograma (EEG cuantitativo) haciendo uso de la tarjeta Cyton y Daisy
de la empresa OpenBCI, ademas del casco malla “EEG electrode cap”. El software vincula
Psychopy, OpenBCI y LabRecorder por medio de LabStreamLayer (LSL); en Psychopy se
digitalizo el paradigma desarrollado por el grupo de investigacion de dafio cerebral de la
Universidad del Azuay, el cual, mediante tareas de razonamiento abstracto, activa regiones
especificas del cerebro las cuales son obtenidas mediante OpenBCI y almacenadas por
LabRecorder. Los parametros que se obtienen pueden ser variados entre los cuales se presenta:
analisis de frecuencia en el tiempo, mapeo cerebral, densidad de potencia espectral, banda de
poder, entre otros. En este proyecto se hizo especial enfoque en el andlisis de la densidad de
potencia espectral cuando existe actividad cerebral al desarrollar los estimulos expuestos en el
paradigma. El software fue probado en cinco participantes de la Universidad del Azuay entre
las edades de 20 y 30 afios. El test tuvo una duracion aproximada de dos minutos por
participante dando resultado la correcta vinculacion del grabado de datos y la presentacion de

los estimulos.

Palabras clave: EEG cuantitativo, OpenBCI, Cyton-Daisy, Paradigma, LabRecorder, LSL,
Psychopy, Tareas Cognitivas Abstractas.

Omar Alua rado - /f £ / ch 7'

Omar Santiago Alvarado Cando Daniel Esteban Iturralde Piedra

Director de Tesis Director de Escuela

&

Pedro Pablo Pesantez Pacheco Mateo José Romero Palacios

Autor Autor



ABSTRACT

EEG BRAIN ACTIVITY ANALYSIS SYSTEM DURING THE PERFORMANCE OF
COGNITIVE TASKS

The following study presents the development of a software for the quantitative analysis of
Electroencephalogram signals (quantitative EEG) using the Cyton and Daisy card of the
OpenBCI company, in addition to the "EEG electrode cap" mesh helmet. The software links
Psychopy, OpenBCI and LabRecorder through LabStreamLayer (LSL); in Psychopy the
paradigm developed by the brain damage research group of the Universidad del Azuay was
digitized, which, through abstract reasoning tasks, activates specific brain regions which are
obtained through OpenBCI and stored by LabRecorder. The parameters obtained can be varied
among which are: time-frequency analysis, brain mapping, spectral power density, power
band, among others. In this project, special focus was made on the analysis of the spectral
power density when there is brain activity when developing the stimuli exposed in the
paradigm. The software was tested on five participants from the University of Azuay between
the ages of 20 and 30 years old. The test had an approximate duration of two minutes per
participant resulting in the correct linking of the data recording and the presentation of the

stimuli.

Keywords: Quantitative EEG, OpenBCI, Cyton-Daisy, Paradigm, LabRecorder, LSL,
Psychopy, Abstract Cognitive Tasks.
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Resumen— En el siguiente estudio se presenta el
desarrollo de un software para el anilisis
cuantitativo de sefiales de Electroencefalograma
(EEG cuantitativo) haciendo uso de la tarjeta Cyton
y Daisy de la empresa OpenBCI, ademas del casco
malla “EEG electrode cap”. El software vincula
Psychopy, OpenBCI y LabRecorder por medio de
LabStreamLayer (LSL); en Psychopy se digitalizo el
paradigma desarrollado por el grupo de
investigacion de daio cerebral de la Universidad del
Azuay, el cual, mediante tareas de razonamiento
abstracto, activa regiones especificas del cerebro las
cuales son obtenidas mediante OpenBCI vy
almacenadas por LabRecorder. Los parametros que
se obtienen pueden ser variados entre los cuales se
presenta: analisis de frecuencia en el tiempo, mapeo
cerebral, densidad de potencia espectral, banda de
poder, entre otros. En este proyecto se hizo especial
enfoque en el analisis de la densidad de potencia
espectral cuando existe actividad cerebral al
desarrollar los estimulos expuestos en el paradigma.
El software fue probado en cinco participantes de la
Universidad del Azuay entre las edades de 20 y 30
aiios. El test tuvo una duracién aproximada de dos
minutos por participante dando resultado la correcta
vinculacién del grabado de datos y la presentaciéon de
los estimulos.

Keywords— EEG cuantitativo, OpenBCI, Cyton-
Daisy, Paradigma, LabRecorder, LSL, Psychopy,
Tareas Cognitivas Abstractas.

LINTRODUCCION

Los test psicologicos permiten medir el
razonamiento abstracto, la capacidad de memoria,
la memoria de corto plazo, atencion, etc.; entre los
cuales citamos al test para RMF (Resonancia
magnética funcional) como WADA (un test no
invasivo), el test de ejercicios de analogias
proporcionales y analogias de coincidencias
semanticas conformado por imagenes y palabras,
el test de Wisc de memoria, test margaritas entre
otros [1] [2] [3] [4].

Segun [5] los paradigmas son tareas
experimentales usadas para mapear la actividad
cerebral a través de electroencefalografia o
resonancia magnética. El uso de los paradigmas
permite conocer las capacidades y actividades
funcionales del paciente al momento de realizar
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dichos test que estimulan las zonas de importancia
del cerebro; estas zonas tienen relacion con la
percepcion, la memoria de aprendizaje,
razonamiento logico, formacion de conceptos, etc.
Se ha incorporado el analisis de biosefiales que
pueden ser medidas y controladas continuamente
en los seres biologicos y se refiere tanto a
biosefales eléctricas como no eléctricas acorde
con la actividad cerebral del paciente.

En los test psicologicos de razonamiento
abstracto se presenta un inconveniente: no se
posee un sistema que realice el test y al mismo
tiempo evalué la actividad cerebral de la persona,
es decir, no existe una sincronizacion entre el test
digitalizado y la actividad cerebral cuando se
presenta una imagen en un tiempo especifico,
debido a que los -electroencefalogramas
comerciales no estan estandarizados por un
mismo protocolo. Por lo que no se puede obtener
los datos para analisis estadisticos cuantitativos o
cualitativos de un EEG que pueda ser interpretado
por diferentes softwares como Python, Matlab,
SPS, etc.

En este proyecto se digitalizara el paradigma
de razonamiento abstracto, desarrollados por el
grupo de investigacion de dafio cerebral de la
Universidad del Azuay [2], por medio de
Psychopy el cual es programado dentro del
entorno de Python.

El EEG es un método electrofisiologico que
se usa para la deteccion y registro de datos de la
actividad bioeléctrica que produce el cerebro
humano para realizar una comparacion por medio
de una diferencia de potencial y un arreglo de
electrodos (de la marca OpenBCI) posicionados
en el sistema internacional 10-20. El uso que ha
tenido estd enfocado a campos de tratamiento,
como el diagnostico de epilepsia, trastornos de
sueflo, enfermedades neurologicas, encefalopatias,
etc.

A. Estado del Arte y Marco Teorico
a. Estado del arte

Un experimento desarrollado en Dinamarca
en la Universidad de Aalborg en 2016, cred un



sistema para distinguir entre la distraccion
cognitiva y el enfoque de los conductores,
llamada Animus. Por medio de un simulador de
conduccion se logro recopilar datos sobre el EEG
de 8 participantes en un trascurso de 2 dias, con
una precision de clasificacion de 98.01%. Se
determind que las ondas cerebrales son lo
suficientemente consistentes durante el desarrollo,
lo que sugiere que Animus distingue entre
distraccion cognitiva y ayuda a que el conductor
se concentre en los dias siguientes. También se
determind que la recolocacion de los cascos EEG
puede llegar a afectar la precision de la
clasificacion del participante [6].

La Universidad Politécnica de Madrid en
Espafia, en 2017 realiz6 un experimento con un
casco EEG aplicando sonidos biaurales a
pacientes con Enfermedad de Parkinson (EP) para
evaluar la influencia que tienen estos sonidos con
los sintomas de la enfermedad. El experimento
consistié en la administracion de ritmos biaurales
ritmicos y el control en dos sesiones al azar
alrededor de 10 minutos por sesion, con un lapso
de siete dias. Los resultados que obtuvieron
fueron la reduccion general de la conectividad
funcional, una disminucién de la actividad theta y
un mejoramiento de la memoria de trabajo. Sin
embargo, no se determinaron cambios
considerables en el rendimiento de la marcha,
nivel de ansiedad o frecuencia cardiaca de los
pacientes [7].

En la India, para la Revista Internacional de
Investigacion Cognitiva en Ciencias, Ingenieria y
Educacion (IJCRSEE), el Departamento de
Electronica de la Universidad Gorakhpur en 2014,
realiz6 una investigacion sobre el desarrollo de un
dispositivo de interfaz EEG, que se basa en los
principios de evaluacion cognitiva, utilizando el
procesamiento de sefiales cognitivas para pruebas
neurofisiologicas basadas en una Interfaz Cerebro
Computador (BCI por sus siglas en ingles). El
resultado esperado de este estudio, fue medir el
efecto de la accion cognitiva en el cerebro
humano por medio del disefio de la interfaz, el
estrés, carga por trabajo, emociones, actividades
neuronales, desordenes, etc [8].

La Universidad Tecnoldgica en Opole-
Polonia 2020 John LaRocco, Minh Dong y Dong-
Guk Paeng, se realizo una revision sistematica de
una opcion de bajo costo para la deteccion de
somnolencia mediante EEG, entre todas las
opciones que se manejaron en este proyecto, se
destaca el sistema OpenBCI Ultracortex. Una de
las pruebas realizadas analiza la salida EEG de un
conductor basado en caracteristicas espectrales
donde se divide las sefales de entrada (delta,
theta, alfa y beta) para medir el nivel de alerta en
que se encontraba el conductor [9].

En la Universidad Politécnica de Cartagena
en Colombia en 2018, Juan Martinez realiza un
sistema de interfaz cerebro-ordenador basado en

dispositivos EEG y modelos difusos aplicados a la
imaginacion de movimiento. En este estudio se
utiliza una BCI combinado con técnicas
neurodifusas teniendo como base un paradigma
centrado en la imaginacion del movimiento. El
experimento utiliza sistemas BCI con Emotiv
EPOC y con la ayuda de 19 voluntarios se
determind que existe una mejora en la deteccion
de ritmos sensomotores durante los procesos de
Desincronizacion  Relacionada con  Eventos
(ERD) y Sincronizacioén Relacionada con Eventos
(ERS) de la imaginacion de movimiento, dando
como resultado un sistema de bajo coste que tiene
una buena adquisicion de datos con una precision
de hasta un 75%, con lo cual se determina que los
sistemas BCI de bajo coste, pueden ser muy
relevantes en un futuro para la comunidad
cientifica [10].

Gabriel Arango y Rodrigo Pardo, realizan un
estudio sobre el EEG cuantitativo para el
diagnéstico  diferencial de la  demencia
degenerativa. Este trabajo tiene como objetivo
evaluar la utilidad del EEG cuantitativo al
momento de diagnosticar pacientes con algun tipo
de demencia. El estudio fue realizado en 66
pacientes potenciales para tener la enfermedad de
Alzheimer; las pruebas fueron realizadas de la
siguiente manera: en primer lugar, se tomaron en
cuenta todos los datos adquiridos por los
electrodos a excepcion de los de la linea media
(Cz, Pz, Oz) y los frontopolares (FP1, FP2), a
partir de los datos se calcula la “r” de Pearson
para las parejas de datos y también se utilizan
métodos estadisticos multivariables de
simplificacion para el analisis de los datos. Como
resultado del estudio se concluye que el EEG
cuantitativo es util para el diagnostico de
demencia organica [11].

En la Universidad de Juarez del Estado de
Durango se realiza un EEG cuantitativo aplicado
al test de Neuropsi, este test analiza las
habilidades cognitivas en pacientes neurologicos.
La prueba fue realizada a 288 alumnos de
medicina, para evaluar el potencial de desempeiio
de los alumnos frente a operaciones de calculo
matematico. Para realizar el estudio de la
actividad cerebral de los estudiantes durante las
pruebas, se usa un EEG cuantitativo, que analiza
los promedios de los ritmos cerebrales, medido en
Hertzios (Hz), y el promedio de la amplitud de la
activad cerebral medida en “pV”. Los resultados
obtenidos dentro de estos estudios, estan dentro de
los parametros normales de acuerdo a los criterios
del test de Neuropsi, dando como conclusion que
la mayoria de los estudiantes tienen un buen
desempefio frente a problemas de calculo
matematico, ademas que los resultados de las
mediciones del EEG cuantitativo también esta
dentro de los parametros normales [12].

Rosita Rahma y Jatmika Nurhadi en 2017,
realizan un estudio que mide la duracion de la
concentracion de las personas durante el proceso



de lectura. Las pruebas fueron realizadas en 16
personas con un rango de edad de 18 a 22 afios, 8
hombres y 8 mujeres. Las pruebas fueron
realizadas en OpenBCI, en la placa Ganglion, y
consistian en registrar las distintas sefiales
eléctricas (delta, theta, alpha, beta y gamma)
obtenidas mediante EEG durante un periodo de
tiempo de 15 min. Para poder comparar los
distintos resultados, hay que tener en cuenta que
una persona en estado de concentracion va a tener
una frecuencia de 15-18Hz, los resultados finales
determinaron que el promedio de tiempo que las
personas se mantienen concentradas en la lectura
es de 11,03 minutos [13].

El Departamento de Neurologia de la Clinica
Mayo en East Shea Boulevard en los Estados
Unidos, realizé un estudio en 2011, en el que se
evalué una medicion cuantitativa de EEG. Estas
medidas proporcionadas por EEG cuantitativo han
servido para el desarrollo de biomarcadores
predictivos que pueden prevenir el deterioro
cognitivo en la EP. Este estudio incluye la
evaluacion de pacientes con EP sin demencia,
mediante la medicion cuantitativa de EEG y la
evaluacion cognitiva posterior, para comprender
las medidas de frecuencia de ritmo de fondo y la
potencia relativa de la banda de frecuencia
correspondiente, y predecir la aparicion de
demencia. El riesgo de demencia en los pacientes
evaluados con una frecuencia de ritmo de fondo
mas baja, fue 13 veces mayor que el de los
pacientes evaluados con una frecuencia de ritmo
de fondo mas alta. En resumen, se ha determinado
que el EEG cuantitativo ademas de medir la
frecuencia del ritmo de fondo y la potencia
relativa pueden incluir algunos posibles
biomarcadores predictivos de la incidencia de la
demencia en la EP [14].

En estudios realizados por Martinez, Vanegas
et. al concluyeron que para el desarrollo de un
buen estudio de las zonas de activacion del
cerebro se debe desarrollar un paradigma que
cumpla con la funcién de activacion de las zonas a
estudiar, para que los resultados obtenidos sean de
correcta  interpretacion.  Los  paradigmas
desarrollados con la funcién de activacion de la
zona explorada permiten relacionar la actividad
encontrada en funciéon de la zona especifica, por
lo que se debe considerar aspectos importantes
para la seleccion correcta o implementacion del
paradigma [15].

Segun Whitaker, Vendetti et al. mediante el
analisis de patrones de activacion neuronal
mediante RMF realizado en nifios y adolescentes,
disenaron dos modelos basados en K-Bit2 para
una prueba corta de inteligencia. El modelo
contenia ejercicios de similitud proporcional y
semantica, compuestos por imagenes y palabras
en color. El tiempo de exposicion para cada
estimulo fue de 10s, durante los cuales se maped
la seleccion de la respuesta y el establecimiento de

relaciones perceptivas abstractas entre las
imagenes [16].

En un estudio realizado por Hammer,
Kramer, Hillman y Barbey se utiliza un
paradigma especializado para RMF el cual trata
de demostrar si el razonamiento analdgico puede
diferenciarse por medio de la activacion de las
zonas prefrontales del cerebro, el paradigma que
se utilizo en estas pruebas consistia en una serie
de estimulos que contenian tanto imagenes como
palabras, en el transcurso de las pruebas la
presentacion de cada estimulo durd alrededor de 8
segundos y los sujetos de prueba debian
determinar las similitudes entre los pares de
imagenes, ademas de los grupos de palabras [17].

En Ecuador se adaptaron y validaron las
siguientes tareas experimentales SIMON, Go/No-
Go y Stroop Victoria los cuales valoran el control
inhibitorio, que es una autorregulacion consciente
del comportamiento, y el control de la
interferencia que ayuda a controlar los impulsos
automaticos durante la atencion selectiva. La toma
de muestras se realiz6 a 100 estudiantes entre 6 y
15 afios de edad, todos estos estudiantes
pertenecian a recintos educacionales publicos,
para validar el estudio primero se tuvo que
obtener la aprobacion de expertos en el campo,
ademas de realizar pruebas piloto [18].

Se puede demostrar que los sistemas de bajo
coste estan siendo utilizados para la adquisicion
de sefiales EEG en estudios cuantitativos. Los
estudios realizados por [5] demuestran que
mediante una interfaz EEG se puede medir el
efecto de la accion cognitiva en el cerebro
humano. Asi mismo los articulos [6-7]
demuestran lo eficiente que resulta utilizar este
sistema ya que poseen una buena adquisicion de
datos con una precisién de hasta un 75%, con lo
cual se determina que los sistemas BCI pueden ser
muy relevantes en un futuro para la comunidad
cientifica. Generalmente los test psicologicos no
estan digitalizados, pero en estudios realizados
por [23-26] desarrollan la exposicion de
paradigmas para estimular zonas de interés en
determinados tiempos mediante pruebas piloto por
lo que es un desafio para los neuropsicologos la
creacion de paradigmas que sean validos para
Resonancia Magnética (RM) que mapeen los
procesos cognitivos superiores que sean capaces
de aportar nuevos conocimientos para la
neurociencia.

b. Marco tedrico
OpenBCI

OpenBCI es capaz de brindar Ila
compatibilidad de codigo abierto con terceros
como puede ser Matlab, Python y otros. La
interfaz que maneja es muy basica y eficaz como
se muestra en la Figura 1 la pantalla principal de
OpenBCIL.
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Figura 1. Pantalla principal de OpenBCI [19].

El desarrollo de diagndsticos y experimentos
pueden ser escaneados por OpenBCI, que son
tratados con una interfaz que combina cerebro-
computadora, conocido de manera comercial
como BCI (Brain-Computer Interface). Existen
varios dispositivos BCI y gracias a algunos
hardware y software gratis de codigo abierto, dan
la posibilidad de sistemas BCI asequibles; los mas
notables son OpenEEG, OpenVIBE y el ya
nombrado antes OpenBCI [20].

Ultracortex “Mark IV”

Ultracortex es un casco de cddigo abierto que
es compatible con toda placa de OpenBCI, este
casco esta disefiado para recibir sefiales de EEG,
cuenta con electrodos de tipo seco y puede
muestrear hasta 16 canales en 35 distintas
ubicaciones dispuestas en sistema 10-20 [21].

Figura 2. Casco Ultracortex "Mark IV".

EEG electrode cap

Este casco contiene electrodos tipo humedo
incrustados en su malla de tipo tela, disefiado para
combinar la mejor calidad de sefial y comodidad
adecuada para estudios que sean enfocados a
permanecer con el casco por varias horas como
estudios de suefio. Compatible con todas las placas
de OpenBCI. Consta de 21 canales con electrodos
sintetizados, ~ posicionados en el  sistema
internacional 10-20. Sus electrodos son a prueba de
tacto de 1.5mm estandarizados en la industria.

Figura 3. Casco Electrode cap.

Sistema 10-20

El sistema 10-20 internacional nos
proporciona informacion para la colocacion de los
electrodos sobre €l cuero cabelludo, se denomina
de esta manera debido al espacio que existe entre
cada electrodo, es decir, de 10% a 20% de la
distancia total entre puntos reconocibles del
craneo [22], los cuales son:

eNasion: Entre la frente y la nariz.
e Inion: Protuberancia occipital.

e Punto Preauricular: En el pabellon de la
oreja

Nasion

" Preaurical
point

Inion 10% b
Figura 4. Punto de colocacion de los electrodos, sistema
10720 [23].

Tareas Cognitivas

Las funciones cognitivas son aquellas
habilidades que el ser humano tiene para recordar
datos importantes, resolver problemas, planear,
atender, memorizar, concentrarse y emplear el
lenguaje, orientacion del ambiente, realizar
calculos, etc.

A lo largo de la vida, se producirdn una serie
de cambios en la funcion cognitiva, estos cambios
se consideran déficits cognitivos (pérdida de
memoria), que llevan a la pérdida paulatina de
estas funciones y afectan el progreso de las
actividades [24].



Figura 5. Funciones cognitivas [25].

Las Gnosias son las capacidades del cerebro
para poder obtener informacioén por medio de los
sentidos. Por ejemplo, nuevos objetos, lugares o
personas, sonidos o imagenes, etc. Existen varios
tipos de Gnosias como lo son:

e Gnosias visuales
e Gnosias auditivas
o Gnosias olfativas
e Gnosias tactiles
o Gnosias gustativas
e Esquema corporal
EEG vinculado con BCI

Este tipo de vinculacion ofrece un conjunto
de sefales que son registradas simultdneamente, a
través de varios canales en los que se encuentran
colocados los electrodos en el sistema
internacional  10-20; estas sefiales estan
registradas simultdneamente como un conjunto de
datos multivariado [26]. La correcta funcion
cerebral y el modelado de dichas funciones, no
necesariamente se basa en la correcta
identificacion de las regiones que estan activas
sino también se consideran las interacciones
funcionales entre las diferentes regiones
cerebrales. La BCI brinda un registro amplio de
ondas cerebrales e imagenes o mapas de calor de
activacion  cortical, encargadas de realizar
operaciones mentales y fisicas.

Estructura de un Sistema BCI

Segiin Gutiérrez-Martinez [27] un sistema
BCI estd compuesto por varias etapas de
procesamiento de las sefiales especificamente en
tres etapas: adquisicién, procesamiento de las
sefiales EEG y su salida.

Procesamiento de sefiales

Extraccion
Adquisicin de Filtrado Amplificacion Digitalizacién A4 salida
sefiales clasificacion

Retroalimentacion

Figura 6. Estructura de un Sistema BCI.

La primera etapa de adquisicion representa la
obtencion de los potenciales bioeléctricos que
son generados por el cerebro, y estas pueden ser
detectadas por medio de los electrodos colocados
en el sistema 10-20 que hacen contacto en el
cuero cabelludo del paciente.

La segunda etapa es la del procesamiento de
seflales EEG, al ingresar en esta etapa se
encuentra en un preprocesamiento de la sefial,
primero en filtrado de la sefial, amplificacion,
digitalizacion y por ultimo extraccion y
clasificacion de la sefal, toda esta etapa de
procesamiento es muy importante ya que se
realiza con el objetivo de eliminar las posibles
sefiales externas o artefactos que contaminen la
sefial del EEG.

Finalmente se encuentra la etapa de salida, en
esta etapa la sefial se encuentra transformada
para que se pueda generar control sobre ellas o
con ellas. Asi mismo es importante tener una
retroalimentacion de la sefial para indicar el
comportamiento y/o rendimiento del paciente.

Diagrama general del equipo.

Software  de

desarrollo libre Ok G Andlisis
OpenBCI de datos

Ultracortex +
Cyton + Daisy
Biosensing
Boards (16
channels)

Sincronizacion de i » almacenamiento

ON/OFF para el los paradigmas de datos

grabado de datos cognitivos.
Escaneo en tiempo

real con OpenBCly
toma de tiempos

Figura 7. Diagrama general del equipo.

Analisis de 1a densidad espectral de potencia

La densidad espectral de potencia informa la
manera de como estd distribuida la potencia o
energia que presenta una seflal en este caso la
sefial de un EEG. Es una funcién matematica que
muestra la distribucion de energia de dicha sefal
en las diferentes frecuencias donde se modula.
Por lo tanto, es posible determinar con qué
frecuencia se enfocan los cambios de poder. Es
muy Util para monitorear el comportamiento de
las sefales en el dominio de la frecuencia, donde
las diferencias se pueden discernir mas



facilmente que en el dominio del tiempo,
permitiendo comparaciones entre amplitudes
provocadas por la seflal y cambios en el
comportamiento del pardmetro en estudio [28].

Log Power Spectral Dansiy 10%0g,(sV2Hz)

2 2
Frequency (Hz)

Figura 8. Densidad espectral de potencia.

3 “

Validacion de un paradigma de razonamiento
abstracto

Para realizar un mapeo del cerebro a través de
RMF con un EEG se utilizan los paradigmas que
son tareas experimentales. El paradigma que se
utilizara para este proyecto se encuentra validado
por los autores en la cita [2]; este cuenta con
tareas de analogias semanticas y visuales
aplicados en jovenes/adultos entre 20 y 30 afios
pertenecientes a la ciudad de Cuenca-Ecuador.
Este paradigma esta disefiado en el software de
desarrollo libre Psychopy 3 orientado al desarrollo
de experimentos de neurociencia.

Las caracteristicas que se deben considerar en
un paradigma en presentacion de bloques como el
que se utilizara, debe ser en la presentacion de los
tiempos, numero de condiciones que se presentan
y la exposicion de los estimulos. Si se muestran
mayor numero de bloques mayor potencia de
exposicion de contraste y alteracion de
estadisticas en el estudio. La recomendacion
optima de tiempo en presentacion de bloques
ronda entre los 14 y 20 segundos, aunque existen
excepciones en donde los bloques pueden
prolongarse hasta un tiempo de 30 segundos
dependiendo de la potencia de estadistica que se
prevé obtener. Otro punto muy importante para
considerar es el tiempo de duracion del
experimento ya que, si el tiempo en el que el
sujeto este realizando el test se extiende, puede
generar ansiedad o cansancio disminuyendo la
validez psicolégica del estudio [2].

Un paradigma debe tener un funcionamiento
en concreto y una explicacion de su
funcionamiento de la capacidad que estudia, con
la finalidad de obtener resultados predichos ante
su ejecucion cuando lo realice el sujeto.

La seleccion de un paradigma se realiza con
base en diferentes criterios, como la capacidad
cognoscitiva, sitio de lesién o naturaleza de los
potenciales trastornos a evitar y la observacion del
rendimiento de la actividad cerebral.

Una evaluacion neuropsicoldgica previa a la
ejecucion del paradigma, ya que a través del

analisis cuantitativo y cualitativo de los
instrumentos aplicados permite una apreciacion
global y especifica de las funciones que se
conservan y que se alteran.

No se puede aplicar un paradigma sin antes
haber conocido el estado cognitivo de sujetos, ya
que algunos pacientes con la misma patologia
cerebral pueden tener alteraciones en sus
componentes del proceso cognitivo u otros
procesos, por lo que se puede provocar
interpretaciones a resultados erroneos.

Para que un estudio sea correcto se tiene que
tener en cuenta la complejidad de las tareas
debido a que puede existir una mala interpretacion
de los participantes dando como resultado un
inadecuado desempefio que pueda alterar la
efectividad del paradigma, por ello es conveniente
ajustar la dificultad de las tareas para que sean
entendibles por todos los participantes [29].

Antes de realizar el estudio es conveniente
entrevistar al participante con el fin de conocer si
estos poseen algun tipo de alteracion de conducta,
sensitiva o motora que impidan a los participantes
seguir de manera correcta las instrucciones del
estudio.

Entorno de Psychopy

Psychopy es un software de codigo abierto
escrito en lenguaje de Python, este software
combina la facilidad de utilizacion de interfaces
graficas de OpenGL con Python con la finalidad
de generar un estimulo de alta precision visual. El
entorno de Psychopy maneja un disefio
minimalista que permite a cualquier persona
implementar diferentes estimulos, por ejemplo:
Visuales, auditivos, motrices, etc. mediante el uso
de scripts. Dentro de este software se puede
presentar diferentes experimentos implementados
a la neuropsicologia en los cuales se pueden
incluir sistemas como EEG, EMG, MEG, entre
otros [30].

El entorno de Psychopy se maneja con tres
ventanas de trabajo las cuales son: Psychopy
Builder, Psychopy Coder, Psychopy.
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Figura 9. Entorno de Psychopy Builder.

En la Figura 9 se muestra la ventana de
trabajo que permite la creacion de los
experimentos neuropsicologicos. En este se puede



implementar una variada gama de acciones en las
cuales se puede incluir: muestra de imagenes por
un tiempo determinado, acciones por teclado o
mouse, etc. En este apartado también se puede
agregar scripts para la implementacion de codigo
en lenguaje de Python que se adjuntara al codigo
interno de Psychopy como se muestra en la
siguiente figura.
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Figura 10. Entorno de Psychopy Coder.

En la imagen anterior se localiza el “Shell” de
Psychopy que permite visualizar las lineas de
codigo existentes en el desarrollo del experimento
realizado. Por ejemplo, existen lineas de codigo
que tienen que ser escritas en lenguaje de Python
para crear un botdn, cargar imagenes, para realizar
retardos en el sistema, etc. Basicamente se puede
decir que a partir de la interfaz grafica de
Psychopy se puede programar sin la necesidad de
escribir lineas de codigo, aunque existan en el
“Psychopy Coder”.
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Figura 11. Entorno de Psychopy Runner.

En la Figura 11 se muestra la ventana de
trabajo permite visualizar la salida del compilador
del entorno de Psychopy, aqui se muestran todas
las alertas y errores que pueda tener el
experimento cuando se lo ejecute.

LSL y Lab Recorder

Significa “Lab Stream Layer” (Capa de
transmision de laboratorio) mostrada en la Figura
12, este es un conjunto de bibliotecas que permite
la recopilacién sincrona de miltiples series de
datos a través de distintos sistemas, para vincular
diferentes experimentos de investigacion. La
interfaz de Lab Recorder que se muestra en la

Figura 13 permite guardar todos los streams que
estan disponibles en la capa de transmision del
laboratorio y su formato de guardado es de tipo
“xdf” (Extend Disk Format) el cual puede ser
procesado en el entorno de Matlab.
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Figura 13. Interfaz de Lab Recorder.

Matlab y EEGLAB

Matlab es un programa que posee un leguaje
de alto rendimiento para la realizacion de célculos
técnicos, una de las mejores caracteristicas de
Matlab es que permite construir herramientas y
entornos de trabajo adecuados a las necesidades
del usuario [32]. EEGLAB es una herramienta de
Matlab que ayuda al procesamiento de datos de
EEG, ademas de proporcionar una GUI (Interfaz
Grafica de Usuario) que permite a los usuarios
procesar los datos de manera interactiva.
EEGLAB tiene la opcion de trabajar con archivos
“. xdf” dando como resultado la interpretacion de
los datos obtenidos del EEG, por Lab Recorder,
con el entorno de Matlab.

4] EEGLAB v2021.0 o X

File & 1 Help »

——No current d

Suggested steps to get started

- Create a new or load an existing dataset:
Use "File > Import data" (new)
or "File > Load existing dataset" (load)
(find tutorial data in sample data folder)

If newly imported raw dataset

"Edit > Channel locations" (look up locations)
“File > Import event info® (for continuous data)
- Filter data: "Tools > Filter data"

- Reject data: "Tools > Reject data by eye"

- Run ICA: "Tools > Run ICA" (can take time)

- Reject by ICA: "Tools > Reject data using ICA™

- Epoch data: "Tools > Extract epochs®

- Plot ERP: "Plot > Channel ERP > In scalp array"

Figura 14. Pantalla inicial de EEGLAB.



II. METODOLOGIA

EL objetivo de este proyecto es desarrollar un
software capaz de adquirir informacion de la
activacion cerebral durante la ejecucion de tareas
cognitivas, con el uso de OpenBCI para el analisis
cuantitativo de EEG.
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En la siguiente figura se muestra el funcionamiento
del sistema desarrollado con tres programas:
OpenBCI GUI, Psychopy y LabRecorder. Los
hardware utilizados son la tarjeta de adquisicion de
sefial Cyton y el casco de malla EEG electrode cap
los cuales fueron detallados en el marco tedrico.
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Figura 15. Diagrama de flujo general del sistema.

Digitalizacion del paradigma

Para el desarrollo del paradigma hay que
tener conocimientos basicos de programacion en
lenguaje de Python ademas de estar familiarizado
con el entorno de Pyschopy, en caso contrario se
debe revisar el manual de uso existente en la
pagina oficial de Pyschopy. Ahora se procede a
explicar las rutinas desarrolladas en el proyecto.

Vinculacion

DOBEHCFRLHER0 0000
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Figura 16. Contenido de la rutina "Vinculacion".

En la Figura 16 se muestra la ventana de
rutina donde se inserta un componente de codigo
y para ello véase en la siguiente figura.
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Figura 17. Insercion de un componente de codigo.

Una vez insertado el componente de cédigo
se procede a abrir las “propiedades de codigo”. En
esta parte se realiza la vinculacion mediante
programacion del Lab Recorder y Cyton + Daisy.

Detener
grabacion de
datos



Cabe resaltar que el codigo tiene que ir al inicio
del experimento.

code Properties

Name [ code CodeType [Py | Oldisabled

Before Experiment Begin Experiment * Begin Routine Each Frame End Routine _ End Experiment *
1
pathlib Path
sys, subprocess, time
sys.path.append(

OpenBCI_LSL =subprocess.Popen(['pyt P n

2
3
4
5
6
7
8
9
o
1 time.sleep(s)

Help

Figura 18. Codigo de vinculacion de Psychopy con los
periféricos.

En las lineas 2 y 3 de la Figura 18 se hace el
llamado a las librerias necesarias para iniciar la
comunicacion, en la linea 4 se da la direccion en
donde estan ubicadas las librerias para la correcta
lectura de las mismas. En la linea 10 se inicializa
un subproceso (python) que abre el codigo que
vincula el programa con las placas Cyton + Daisy
mediante LSL y finalmente en la linea 11 un
tiempo de espera a la conexion.

Ahora dentro de las propiedades de codigo se
pasa a la pestaiia “Final del Experimento” donde
se termina el subproceso inicializado en la linea 9.

CodeTpe Atosss - Clguied

g par cvineEachframeEndRtine_ End Bpiment™
1 OpenBCI_LSL.kiTL( 1 OpendCI_LSL.KELLO:
2 20 Record.kiTLO 2 X0F Record.KTLO

o ok coma

Figura 19. Como terminar un subproceso.

Reglas
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Figura 20. Contenido de la rutina "Reglas"”

En la rutina de la Figura 20 se agregan los
siguientes componentes: texto, respuesta de
teclado y codigo. Ahora se ingresa a las
propiedades de cada componente para hacer las
configuraciones como se puede ver a
continuacion:

Basic  Layout Appesrance Formatting Date  Testing

Introduccion

time (5)

duration (5)

O 00

correcta son presione P si considera
que la respuesta correcta son los numeros de la derecha.

Presione espacio para continua. constant

Help oK Cancel

Figura 21. Propiedades de texto.

En la figura anterior en las propiedades de
texto se procede a configurar el nombre de la
variable de texto, en este caso se utilizd el nombre
de “introduccion”, luego el tiempo de inicio de la
componente de texto, en este caso se pone “0”
para que se active al comenzar la rutina. En el
tiempo de paro se deja vacio para que el texto se
contintie mostrando y al final se escribe el texto
que se desea presentar, en este caso las reglas para
la realizacion del paradigma.

Basic Data Testing
key_resp

time 5) 0

duration (5)

6 @0

Force end of Routine @

s 'space’ constant

Help 3 Cancel

Figura 22. Propiedades de respuesta por teclado.

La Figura 22 muestra las propiedades de
respuesta de teclado seran configuradas como se
muestra en la figura anterior el nombre de la
variable, el tiempo de inicializacion y el tiempo de
paro, como se puede ver ahora se tiene un nuevo
campo llamado “Allowed key” en donde se coloca
el nombre de la tecla que generara una respuesta o
un cambio en nuestro programa, en este caso hace
que se termine la rutina debido a que esta marcado
el checkbox llamado “Force end of Routine”.

En la siguiente figura se puede ver las
propiedades de codigo de esta rutina:

Figura 23. Propiedades de codigo de la rutina "Reglas”.

En la imagen anterior se debe tener en cuenta
que esta porcion de codigo tiene que ser
implementada en la pestaiia “End Routine” para
iniciar el funcionamiento del mismo luego de
pulsar la tecla “space”. En la segunda linea de
codigo se guarda en una variable la fecha en la
que se realiza el experimento, en la tercera el



nombre del participante, en la linea cuatro se abre
el Lab Recorder para empezar la grabacion de los
datos obtenidos de los electrodos. En la quinta
linea se especifica la ruta donde se guardara los
datos y por ultimo en la linea 8 se da paso al
subproceso del grabado de datos para que esté
activo en lo que dura la prueba del paradigma.

En este punto se crea una nueva rutina
titulada “routine_1” en la cual se agregan tres
componentes, las cuales son: imagen, repuesta de
teclado y texto. Esta rutina tiene incluido un bucle
que ayuda a validar las respuestas que el sujeto de
prueba escoja en cada imagen del paradigma.

Routine_1y Setl

0OBEHEIROER0 Q06
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Figura 24. Builder de "routine 1".

Lo primero que se hace en esta rutina es abrir
las propiedades de imagen y se las configura
como se puede ver en la siguiente figura.

Basic Layout Appesrance Texture Data  Testing
Neme  imagenes

time () 00
Start

duration 5
Stop

mage  $NaneInagen O seeeyrpat -

Help oK Cancel
Figura 25. Propiedades de imagen de la rutina
"routine_1".

Hay que tener en cuenta que la imagen se
muestra al comenzar la rutina y tiene un tiempo de
duracion indefinido, en el apartado “Image” se
asigna el nombre “$Namelmagen” para poder
obtener las imagenes ilustradas en cada ventana, a
esto se le agrega la opcion “set every repeat”,
seleccionada en el combo box que se encuentra en
la parte inferior derecha, para que la imagen se
repita con cada reinicio del bucle.

Basic Data  Testing
Name key_resp_3

time (s) 00
Start

duration (5)
Stop

Force end of Routine @

Allowed keys s 'a','p’ constant

Help (3 Cancel

Figura 26. Respuesta de teclado de la rutina "routine 1".

En las propiedades de respuesta de teclado se
asigna las teclas “q” y “p” en el apartado de
“Allowed keys”. Estas teclas serviran para elegir
la respuesta a cada imagen presentada, cada
imagen tiene dos posibles respuestas que estan
escritas en la parte inferior de cada pregunta. Si el
sujeto de pruebas presiona la tecla “q” entonces
escogid la opcion que se encuentra en la parte
inferior izquierda y en caso de que presione la

letra “p” se valida la respuesta de la parte inferior
derecha.

El siguiente paso es dar clic sobre el bucle
llamado “Setl” para abrir las propiedades del
mismo para proceder a su configuracion.

Name Setl

loopType sequential

Istrials @

nReps s 1

Selected rows 0:4

random seed §

Conditions  image_stimulixlsx wllf7)
19 conditions, with 2 parameters

[Namelmagen, left_right]
Help oK Cancel

Figura 27. Propiedades del bucle de "routine 1"

Lo primero que se configura es el nombre de
bucle, como ya se explicod antes, es del “Setl”, el
siguiente apartado es el de “nRpes” que nos indica
el nimero de repeticiones del bucle, entonces se
escogid una sola repeticion por imagen. Para
llenar la casilla de “Conditions” primero se tiene
que crear un archivo de Excel, dentro de la misma
carpeta donde se encuentre el ejecutable de
Psychopy, donde se especifiquen todas las
respuestas implicadas en el paradigma. Por
ultimo, en el apartado “Selected rows” se
selecciona las casillas dentro del archivo de Excel
que se van a comparar en “routine_1”.

Para la correcta configuracion del archivo de
Excel para este proyecto se cred dos columnas con
el nombre de “Namelmagen” y “left right”. En



“Namelmagen” se especifica la ubicacion de cada
imagen para ser llamadas después desde las
propiedades de imagen de “routine 1”. En
“left right” se coloca las respuestas correctas a
cada pregunta para su posterior comprobacion.

Namelmagen left_right
images/Imagen 1.png q
images/Imagen 2.png
images/Imagen 3.png
images/Imagen 4.png
images/Imagen 5.png
images/Imagen 6.png
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10 images/Imagen 9.png
11 images/Imagen 10.png
12 |images/Imagen 11.png
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Figura 28. Contenido del bucle desarrollado en Excel.

Hay que tener en cuenta que cada rutina que
contenga imagenes del paradigma tendra la misma
configuracion de “routine 17, pero en el proyecto
se utilizo el nombre de “routine 2” para
diferenciar entre las pruebas que contengan
analogias semanticas y visuales.

Cruz

Posterior a la rutina “routine 1” se crea otra
con el nombre de cruz, como se puede observar en
la Figura 29 donde se inserta un componente de
imagen, la cual tendrd una duracion de 5 segundos
con la finalidad de dar reposo a los participantes
para el posterior desarrollo de otro banco de
preguntas. Se insertara una rutina “Cruz” cada vez
que termine una rutina que contenga los
estimulos.
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Figura 29. Entorno de la rutina "Cru

Basic Layout Appearance Texture Data Testing
Name  cruz

time (s) 0
Start

duration (5)
Stop

Help oK Cancel
Figura 30. Configuracion de las propiedades de imagen
S JE S
de la rutina "Cruz".

En la figura anterior en la casilla “Image” se
indica la ruta en la que se encuentra ubicada la
imagen que se carga en esta rutina la cual es
mostrada en la Figura 31.

Figura 31. Imagen presentada en la rutina "Cruz".

Set2/Set3/Set4

La configuracion de las propiedades de los
siguientes bucles son las mismas, pero en el
apartado “Selected rows” se cambian las casillas
que se utilizan en el documento de Excel como se
puede ver en la siguiente figura.

Name set2

loopType sequential

Is trials
nReps s 1
random seed  §
Conditions image_stimuli.xlsx o I
19 conditions, with 2 parameters
[Namelmagen, left_right]
Help oK Cancel

Figura 32. Propiedades del set 2.

III. RESULTADOS

En base a los objetivos planteados para este
proyecto, uno de los principales es la obtencion de
datos para usarlos como EEG cuantitativo al
momento de hacer un analisis de los resultados.
Se debe tomar en cuenta que, para una mejor
adquisicion de dichos datos, se considerd que los
sujetos de prueba tengan el cabello limpio y corto.
En el caso de las mujeres que poseen el cabello
mas voluminoso se despejo un poco la zona de
contacto del electrodo del casco EEG para que los
resultados fueran los correctos al momento de
analizar y no sean confundidos por ruido
producido por el cabello.

Para este estudio se considerd los siguientes
electrodos posicionados en el sistema 10-20: F3,
F4, P3, O1 y O2 los cuales obtienen las sefiales de
interés para el estudio. La prueba se realizd en
cinco sujetos (dos mujeres y tres hombres), los
cuales son estudiantes universitarios entre la edad
de 20 y 30 afios; también se consideré que los
sujetos no tuvieran problemas neurologicos ya
que estos podian alterar el objetivo de estudio del
paradigma que se les presento.



Las muestras obtenidas por cada participante
fueron almacenadas y grabadas para su posterior
analisis de las ondas de activacion para cada
pregunta. Los datos fueron analizados por la
herramienta de EEGLAB, en donde se filtraron
unicamente los canales de interés anteriormente
mencionados. En la siguiente tabla se presenta los
distintos participantes, cada uno con su Densidad
de Potencial Espectral (dB) que fue obtenida a
partir del promedio de dos valores, un maximo y
un minimo para cada estimulo por participante y
un promedio de los estimulos por set.

Tabla 1: Datos de los participantes.
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Figura 33. Grdfica promedio de los estimulos del
participante 1.

Como se observa en la Figura 33 el paciente
demuestra una mayor actividad cerebral al
comenzar el test. También se observa que existe

Datos de los participantes otro incremento al empezar el estimulo ntimero
Participante Sexo Edad nueve y a medida que avanza en el test la
1 Femenino 22 activacion cerebral disminuye paulatinamente.
2 Masculino 25 Tabla 3: Resultados del participante 2.
3 Masculino 30
4 Masculino 23 S Promedio bromedio
5 Femenino 20 e por por set
t estimulo (dB)
El test planteado consta de quince imagenes, Estimulo (dB)
tres sets divididos en cuatro imagenes y el ultimo 1 -3,589
set de tres imagenes. Ademas, entre cada set de 1 2 -1,868 2 67025
imagenes se presenta otra denominada "Cruz de 3 -2,206 ’
fijacion", que se utiliza para enfocar la mirada 4 -3,018
después de cada estimulo visual, ademéas de que 5 -3,522
es una manera de descanso; el tiempo de 6 -3,128
muestreo de cada diapositiva es incierto, porque 2 7 -4,59 -3,15875
cada participante puede tomarse el tiempo para ) 1,395
dar la mejor respuesta y el tiempo en el que se 9 1,125
muestra la cruza de fijacion es de 5 segundos. 5 12 8222 030475
Tabla 2: Resultados del participante 1. -
12 -2,315
13 -1,189
Promedio Promedio 4 14 -3,712 -2,2723
por 15 -1,916
t estimulo p?)(;;)et Total=
Estimulo (dB) -2,090
1 3,644
2 6,2606 Promedio por estimulos dB
1 3 "1.083 1,43515 i P
4 -3,081
5 -3,949 ’ 0 5 10 15 20
6 -2,721 -2
2 7 6,486 -4,48625 .
8 -4,789
9 0,298 @
10 -1,106 Figura 34. Grafica promedio de los estimulos del
3 11 4,426 -1,16875 participante 2.
g 02532 Cqmo se pqede ver en la. .F igura 34 el
4 1a o 6’ 12 13403 part}mpante dos tiene una alta actividad cerebral a
s _0’ 127 ’ partir del estimulo. nueve al once y después su
Toltal= actividad cerebral disminuye en el resto del test.
-1,3933

Tabla 4: Resultados del participante 3.



Estimulo

Promedio
por
estimulo
(dB)

Prom
edio
por
set
(dB)

-2,334

-3,732
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Figura 35. Grdfica promedio de los estimulos del

participante 3.

Como se puede en la Figura 35 este participante
comenzo con una baja actividad cerebral hasta llegar
al estimulo diez en donde tuvo un aumento hasta
llegar al estimulo catorce y disminuyendo en el

estimulo quince.

Tabla 5: Resultados del participante 4.

S

Estimulo

Promedio
por
estimulo
(dB)

Promedio
por set
(dB)

-8,684

-5,112

-8,177

-8,08075

-10,35

-10,928

-9,58

-9,113

-9,8534
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3 ! -4,83325
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12 -2,656
13 -5,487

4 14 -9,105 -6,97
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Total=
-7,4644
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Figura 36. Grdfica promedio de los estimulos del
participante 4.

En la Figura 36 se muestra la actividad cerebral
del participante cuatro la cual tiene un pico en el
estimulo dos y luego se mantiene con baja actividad
hasta llegar al estimulo nueve, por ultimo, en el
estimulo doce ocurre el pico mas grande de
actividad cerebral.

Tabla 6: Resultados del participante 5.

S Promedio Promedio

por or set

estimulo P

t (dB)
Estimulo (dB)
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Figura 37. Grafica promedio de los estimulos del
participante 5.
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En la Figura 37 se puede apreciar que los
estimulos en las que el participante cinco tuvo
mayor activada cerebral fueron: uno, dos, cinco,
nueve y once.

En la siguiente figura se muestra la activacion
cerebral de los participantes por set, para realizar un
analisis mas general sobre la complejidad de los sets
que se le presentan a los participantes.

Promedio de los pacientes SET 1

—— Paciente 1

Paciente 2

—— Paciente 3

|

Paciente 4

Paciente 5

Densidad de potencia expectral

Nimero de estimulo en el Set

Figura 38. Promedio de actividad cerebral de los
participantes en el set 1.

En la Figura 38 se puede apreciar que el
participante uno tuvo mayor activadad en el
estimulo dos del set 1, el participante dos genera
mas actividad en el estimulo dos, el participante tres
tiene mas actividad en el estimulo cuatro al igual
que el paciente 5, por ultimo el paciente cuatro es el
que menos actividad cerebral tuvo que el resto de
participantes al momento de realizar el set 1

Promedio de los pacientes SET 2

= Paciente 1

2
/ Paciente 2
4 — S e Paciente 3

Paciente 4
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Ntmero de estimulo en el Set

Figura 39. Promedio de actividad cerebral de los
participantes en el set 2.

En la Figura 39 se puede apreciar que el
participante uno tiene un aumento de actividad
cerebral al pasar del primer estimulo al segundo,

para posteriormente tener un decremento en el
tercero y volver a aumentar hacia el ultimo estimulo.
Por otro lado, el participante dos tiene una actividad
cerebral con pocas variaciones hasta llegar al tercer
estimulo en el cual aumenta alcanzando su mayor
actividad en el cuarto estimulo. El participante tres
tiene un aumento de actividad cerebral constante
hasta llegar al tercer estimulo en el cual su actividad
cerebral decrece hasta resolver el cuarto estimulo.

El participante cuatro mantiene una actividad
cerebral relativamente baja en todo el desarrollo del
test. Por ultimo, el participante cinco tiene su punto
de mayor activada cerebral en primer estimulo,
decreciendo de manera considerable en el segundo y
subiendo otra vez en el tercero para mantenerse casi
con el mismo valor hasta el cuarto estimulo.

Promedio de los pacientes SET 3

/ 2 4 ——Paciente 1
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Figura 40. Promedio de actividad cerebral de los
participantes en el set 3.

En la figura anterior el participante uno tiene
una baja de actividad cerebral al pasar el primer
estimulo al segundo, posteriormente su actividad
cerebral decrece mucho mas para posteriormente al
finalizar el tercer estimulo alcanzar el mayor pico de
actividad cerebral en la resolucién del cuarto
estimulo. Analizando el desempefio del segundo
participante se puede decir que su actividad cerebral
va descendiendo a medida que avanzé con la
resolucion del set 3. El participante tres alcanza su
mayor actividad cerebral en el segundo estimulo,
para luego disminuir en el tercero y al final volver a
subir su activada cerebral, aunque con menor
intensidad en el cuarto estimulo.

El participante cuatro tiene sus niveles mas
bajos de actividad cerebral en los estimulos dos y
tres, siendo el punto mas alto en el estimulo cuatro.
Para finalizar el participante cinco posee una
disminucion de actividad cerebral al pasar del
primer estimulo al segundo, después aumenta la
actividad cerebral en el tercer estimulo siendo este el
pico mas alto para este participante.
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Figura 41. Promedio de actividad cerebral de los
participantes en el set 4.

Como se muestra en la Figura 41 el
participante uno aumenta paulatinamente su
actividad cerebral hasta alcanzar su nivel mas alto en
el tercer estimulo del set 4. La curva del paciente
dos nos indica que su actividad cerebral baja en el
estimulo dos para posteriormente aumentar en el
desarrollo del tercer estimulo. El paciente tres
disminuye su actividad cerebral hasta alcanzar su
minimo en el estimulo tres. Por otro lado, el
participante cuatro tiene un decremento de actividad
cerebral al pasar del primer estimulo al segundo,
para posteriormente aumentar en el tercero.

Para finalizar el participante cinco aumenta su
actividad cerebral de manera gradual hasta alcanzar
su maximo en el tercer estimulo del set 4.

Comparacién de pacientes por set

2 3 i
Nimero de Set

Figura 42. Comparacion del promedio de activacion
cerebral de los participantes en todos los sets.

En la Figura 42 se puede apreciar una
comparativa del rendimiento promedio de cada
participante por set, analizando este grafico de
barras se puede decir que los participantes tuvieron
mayor actividad cerebral al momento de realizar el
set 3 y menor actividad cerebral al realizar el set 2.

IV. CONCLUSIONES

A partir de los resultados obtenidos se puede
decir que es posible obtener datos de OpenBCI para
usarlos en un andlisis de EEG cuantitativo, ademas
en el entorno de Psychopy se puede sincronizar las
sefiales de EEG cuando se presenta un paradigma de
tareas cognitivas, en este caso estimulos abstractos.
Con la ayuda de un cursante de maestria en
neuropsicologia fue posible validar el
funcionamiento del sistema en 5 participantes en
edades de 20 a 30 afios. Se puede decir que el
software desarrollado en este proyecto puede
adquirir sefiales de activacion cerebral durante la

ejecucion de tareas cognitivas para su posterior
analisis cuantitativo.

Durante las pruebas realizadas se concluyo que
el casco “Ultracortex IV” adquirido anteriormente
por la Universidad del Azuay no proporciond
buenos resultados debido a que el tamafio del casco
no se ajustaba de manera correcta a la diferente
anatomia de la cabeza de los participantes, ademas
el tipo de electrodo que utilizaba este casco (tipo
seco) generaba demasiados artefactos al momento de
realizar la lectura de las sefiales durante la ejecucion
del paradigma, por lo que se adquirié un casco (EEG
electrode cap) de tamafio medio con estructura de
tipo malla y electrodos sintéticos, los cuales con la
ayuda de un gel conductor lograban la correcta
lectura de las biosefiales.

Durante el desarrollo del paradigma de
determind que los estimulos mostrados por set eran
de cuatro imagenes, con la finalidad de evitar que el
desarrollo del mismo se vuelva agotador para los
participantes y prevenir sefiales erroneas durante la
toma de las mismas.

Con las sefiales adquiridas durante las pruebas
se concluyo lo siguiente:

e FEl paciente con mayor variacion de
actividad cerebral durante el desarrollo del
paradigma es el participante numero cinco
como se puede ver en la Figura 42 esto
quiere decir que el participante tuvo
diferente grado de complejidad al momento
de resolver los distintos estimulos.

e En base al analisis realizado de la Figura
42, se puede decir que el set 3 es el que
tuvo mayor grado de activacion cerebral,
dando a entender que este set es el que
gener6 mayor complejidad a los
participantes.

Las biosefiales adquiridas por el software
deben ser procesadas de manera eficaz y rapida, por
lo que se recomienda una computadora con un
procesador i7 de octava generacion para evitar
pérdidas en el procesamiento de datos.

V. TRABAJOS FUTUROS

Se propone que este trabajo sea util para el
desarrollo de otras aplicaciones como la inclusion de
imagineria motora a partir de las sefiales de
adquisicion generadas por este software. También la
insercion de sistemas de escaneo en la etapa de
sueflo para conocer el comportamiento del
individuo, asi como la creacion de un test de
evaluacion para ser usado a manera de un poligrafo
por medio del casco de OpenBCI y el sistema
planteado en este proyecto con Psychopy.
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VII. ANEXOS

Tabla 7: Tiempos de respuesta del
participante uno a los estimulos.
Participante: 1
. Inicio Fin
Estimulo
(seg) (seg)
1 0,000 3,486
2 3,486 4,765
3 4,765 6,315
4 6,315 7,885
5 12,855 14,845
6 14,845 16,385
7 16,385 18,865

8 18,865 21,620
9 26,615 35,485
10 35,485 41,115
11 41,115 44,075
12 44,075 52,240
13 57,240 60,250
14 60,250 67,895
15 67,895 72,485
Tabla 8: Tiempos de respuesta del
participante dos a los estimulos.
Participante: 2
Estimulo Inicio Fin
(seg) (seg)
1 0,000 2,310
2 2,310 7,430
3 7,430 9,950
4 9,950 11,570
5 16,570 18,850
6 18,850 20,490
7 20,490 23,050
8 23,050 24,500
9 30,400 35,230
10 35,230 39,800
11 39,800 44,520
12 44,520 49,570
13 54,570 58,610
14 58,610 64,270
15 64,270 68,630
Tabla 9: Tiempos de respuesta del
participante tres a los estimulos.
Participante: 3
. Inicio Fin
Estimulo
(seg) (seg)
1 0,000 2,638
2 2,638 4,154
3 4,154 5,838
4 5,838 9,041
5 14,041 15,559
6 15,559 18,357
7 18,357 21,523
8 21,523 23,509
9 28,509 35,197
10 35,197 41,749
11 41,749 53,331
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83,360

88,730

15

88,730

95,070

12 53,331 58,210
13 63,210 72,151
14 72,151 81,712
15 81,712 88,669
Tabla 10: Tiempos de respuesta del
participante cuatro a los estimulos.
Participante: 4
Estimulo Inicio Fin
(seg) (seg)
1 0,000 2,850
2 2,850 4,800
3 4,800 6,790
4 6,790 8,880
5 13,880 16,900
6 16,900 19,190
7 19,190 21,500
8 21,500 25,080
9 30,080 48,180
10 48,180 59,290
11 59,290 66,390
12 66,390 71,390
13 76,390 82,010
14 82,010 87,490
15 87,490 95,750
Tabla 11: Tiempos de respuesta del
participante cinco a los estimulos.
Participante: 5
Estimulo Inicio Fin
(seg) (seg)
1 0,000 10,350
2 10,350 14,620
3 14,620 17,120
4 17,120 20,120
5 25,120 31,990
6 31,990 34,870
7 34,870 39,840
8 39,840 41,660
9 46,660 54,140
10 54,140 58,340
11 58,340 65,290
12 65,290 71,870
13 76,870 83,360

Figura 43 Participante uno.

Figura 44 Participante dos.

Figura 45 Participante tres




Figura 46 Participante cuatro

Figura 47 Paciente cinco
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